
BAB 6

Modul: Membuat Data Vektor

Membuat peta menggunakan data yang sudah ada hanyalah permulaan saja. Di modul ini,

Anda akan mempelajari bagaimana memodifikasi data vektor yang sudah tersedia dan membuat

sebuah dataset yang sama sekali baru.

6.1 Pelajaran: Membuat Sebuah Dataset Vektor Baru

Data yang Anda gunakan harus diperoleh dari suatu tempat. Untuk aplikasi yang bersifat

umum, data mungkin sudah tersedia, tetapi lebih aplikasi khusus atau proyek yang bersifat

spesifik, kemungkinan bahwa data sudah tersedia adalah kecil. Dalam hal ini, Anda harus

membuat data Anda sendiri.

Tujuan dari pembelajaran ini: untuk membuat datasetset vektor baru.

6.1.1 Ikuti Bersama: Dialog Pembuatan Layer

Sebelum Anda dapat menambahkan data vektor baru, Anda perlu dataset vektor untuk ditam-

bahkan. Dalam latihan ini, Anda akan membuat data yang sama sekali baru, bukan mengedit

dataset yang telah ada. Oleh karena itu, Anda harus mendefinisikan dataset sendiri yang baru

anda terlebih dahulu

Anda membutuhkan kotak dialog New Vector Layer untuk menetapkan sebuah layer baru.

• Arahkan dan klik pada daftar Layer → New → New Shapefile Layer.

Anda akan mendapatkan kotak dialog berikut:
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Pada tahap ini penting untuk menentukan jenis dataset yang Anda inginkan. Setiap jenis layer

vektor “dibangun berbeda” di latar belakang, sehingga begitu Anda telah membuat layer, Anda

tidak dapat mengubah jenisnya.

Untuk latihan selanjutnya, kita akan membuat feature baru yang mendeskripsikan luasan. Un-

tuk feature semacam ini, anda harus membuat sebuah dataset berupa polygon.

• Klik pada tombol Polygon:
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Hasil dari kotak dialog ini adalah tipe geometri yang benar akan diberikan ketika dataset vektor.

Kolom berikutnya adalah untuk menentukan Sistem Referensi Koordinat (Coordinate Referen-

ce System=CRS). Sebuah CRS menentukan bagaimana mendefinisikan suatu titik di bumi da-

lam hal koordinatnya.Karena terdapat banyak cara untuk melakukan ini, maka terdapat banyak

CRS yang berbeda. CRS dalam latihan ini adalah WGS84, jadi sudah benar secara default:

Berikutnya ada sekumpulan kolom yang terdapat dalam New attribute. Secara default, layer

baru hanya memiliki satu atribut, yaitu kolom id (Anda bisa melihatnya di Attributes list).

Agar data yang Anda buat menjadi berguna, perlu ada deskripsi tentang fitur tersebut. Kita

akan menambah satu kolom yang disebut name.

• Ikuti pengaturan berikut, kemudian klik tombol Add to attributes list:

• Periksa apakah kotak dialog Anda terlihat seperti ini :

6.1. Pelajaran: Membuat Sebuah Dataset Vektor Baru 105



Quantum GIS Training Manual, Rilis 1.0

• Klik :guilabel:‘OK. Sebuah penyimpanan dialog akan muncul.

• Arahkan ke direktori exercise_data.

• Simpan layer baru anda sebagai:kbd:school_property.shp.

Layer baru seharusnya terlihat pada Layers list.anda.
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6.1.2 Ikuti Bersama: Sumber Data

Bila anda membuat data baru, obyeknya harus benar-benar obyek yang ada. Anda harus men-

dapatkan informasi mengenai obyek tersebut dari suatu tempat.

Ada banyak cara untuk memperoleh data tentang obyek. Misalnya , Anda bisa menggunakan

GPS untuk merekam koordinat titik-titik di permukaan bumi, kemudian mengimpor data ke

QGIS. Atau menggunakan teodolit dan memasukkan koordinat secara manual untuk membuat

fitur baru. Atau bisa menggunakan proses digitasi untuk melacak obyek dari data penginderaan

jauh, seperti citra satelit atau foto udara.

Untuk contoh kita. Anda akan menggunakan pendekatan digitasi. Sampel dataset raster telah

disediakan, jadi Anda akan mengimpornya mereka seperlunya.

• Klik pada tombol Add Raster Layer:

• Arahkan ke exercise_data/raster/.

• Pilih file 3420C_2010_327_RGB_LATLNG.tif.

• Klik Open. Sebuah peta akan termuat pada peta Anda.

• Cari citra tersebut dalam Layers list.

• Klik dan seret ke bagian bawah Layer list sehingga layer yang lain dapat terlihat.

• Temukan dan perbesar daerah ini :
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Anda akan mendigitasi tiga bidang di sini:
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• Sembunyikan semua layer kecuali layer raster dan school_property.

Untuk memulai digitasi, Anda harus masuk edit mode. Perangkat lunak GIS umumnya meng-

atur ini untuk mencegah dari ketidaksengajaan Anda mengedit atau menghapus data penting.

Mode edit diaktifkan atau dimatikan secara individual untuk setiap layer.

Untuk masuk ke mode edit untuk layer school_property layer:

• Klik pada layer didalam Layer list untuk memilihnya. (Pastikan bahwa layer yang benar

telah dipilih, supaya tidak mengedit layer yang salah!)

• Klik pada tombol Toggle Editing.

Jika Anda tidak dapat menemukan tombol ini, periksa toolbar Digitizing sudah aktif. Harus

ada tanda centang di sebelah menu entry View → Toolbars → Digitizing.

Saat Anda berada pada mode edit tool digitasi sekarang sudah aktif:
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Penjelasan gambar dari kiri ke kanan adalah :

• Toggle Edit: mengaktifkan/menonaktifkan mode edit.

• Save Edits: menyimpan perubahan yang dibuat pada layer.

• Add Feature: memulai digitasi sebuah fitur baru.

• Move Feature(s): memindahkan seluruh fitur ke sekitarnya.

• Node Tool: memindahkan hanya satu bagian dari sebuah fitur.

• Delete Selected: menghapus fitur yang di pilih (hanya fitur aktif yang dipilih).

• Cut Features: memotong fitur yang dipilih (hanya fitur aktif yang terpilih).

• Copy Features: menggandakan fitur yang terpilih (hanya fitur aktif yang terpilih).

• Paste Features: tempel dari hasil potongan atau hasil penggandaan dari fitur peta (hanya

aktif jika fitur sudah dipotong atau digandakan).

Anda ingin mengisi fitur baru.

• Klik tombol Add Feature untuk memulai mendigitasi jalan

Anda akan melihat bahwa kursor mouse Anda telah menjadi benang silang. Hal ini memung-

kinkan Anda untuk lebih akurat menmpatkan poin yang akan didigitasi. Ingat bahwa ketika

Anda menggunakan alat digitasi, Anda dapat memperbesar dan memperkecil peta Anda de-

ngan menggulung roda mouse, dan Anda dapat menjelajah dengan menekan roda mouse dan

menyeret di sekitar peta.

Fitur pertama yang akan didigitasi adalah lapangan olahraga:
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• Mulailah mendigitasi dengan mengklik poin dimanapun sekitar tepi lapangan.

• Tempatkan poin berikutnya dengan mengklik di sepanjang tepi, sampai bentuk bidang

yang tergambar benar – benar seperti lapangannya.

• Untuk menempatkan poin terakhir, klik kanan dimanapun Anda inginkan. Ini mengakhiri

kelengkapan fitur dan menunjukkan dialog Attributes .

• Isikan nilai – nilai berikut :
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• Klik OK dan Anda dapat membuat fitur baru!

Jika Anda membuat kesalahan ketika mendigitasi, Anda selalu dapat mengeditnya selesai pem-

buatan. Jika Anda membuat kesalahan, terus digitasi sampai Anda selesai membuat fitur seperti

di atas, kemudian :

• Pilih fitur dengan tool Select Single Feature:

Anda dapat gunakan:
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• Tool Move Feature(s) untuk memindahkan seluruh fitur,

• Node Tool untuk memindahkan hanya satu poin saat Anda salah mengkliknya.

• Delete Selected untuk menghapus fitur keseluruhan sehingga Anda dapat mencoba lagi,

dan

• Menu Edit → Undo atau ctrl + z untuk membatalkan langkah terakhir Anda.

6.1.3 Coba Sendiri...

• Digitasi sekolah itu dan apangan diatasnya. Gunakan gambar ini untuk membantu Anda:

Ingat bahwa setiap fitur baru perlu memiliki nilai id unik!

Catatan: Ketika Anda sudah menyelesaikan pengisian fitur ke layer: jangan lupa untuk me-
nyimpan hasil editan Anda dan kemudian keluar dari mode edit.

6.1. Pelajaran: Membuat Sebuah Dataset Vektor Baru 113



Quantum GIS Training Manual, Rilis 1.0

6.1.4 Coba Sendiri...

• Buat garis fitur baru yang disebut river.shp dengan atribut id dan type. (Gunakan

pendekatan di atas untuk membimbing Anda)

• Digitasi sungai yang mengalir sepanjang kota

Mulai dari tepi sungai berpasir yang pertama terlihat :

Dan berhenti ketika sungai sudah bergabung dengan sungai lainnya:
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Aliran sungainya tidak selalu terihat sehingga lebih baik menggunakan penilaian Anda dan

perkiraan dimana aliran sungai itu. Ingat bahwa Anda mendigitasi sungai pada skala besar,

jadi cobalah untuk mengikutinya secara detil. Luangkan waktu, jangan biarkan baris menjadi

terlalu lurus atau membuat sudut terlalu tajam!

Ketika membuat fitur tersebut , berikan nilai atribut type sebagai “stream”.

Periksa hasil Anda

6.1.5 Kesimpulan

Sekarang Anda tahu cara membuat fitur! Latihan ini tidak meliputi menambahkan fitur titik,

karena itu tidak terlalu diperlukan ketika Anda telah bekerja dengan fitur yang lebih rumit (garis

dan poligon). Cara kerjanya persis sama, kecuali bahwa Anda hanya klik sekali di lokasi titik

Anda , memberikan atribut seperti biasa, dan maka fitur dibuat.

Mengetahui bagaimana digitasi penting karena hal itu merupakan kegiatan yang sangat umum

dalam program GIS.
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6.1.6 Apa Selanjutnya?

Fitur pada sebuah layer SIG tidak hanya gambar, tapi juga benda di ruang. Misalnya, polygon

yang berdekatan mengetahui di mana mereka dalam kaitannya dengan satu sama lain. Inilah

yang disebut dengan topology. Dalam pelajaran berikutnya Anda akan melihat contoh mengapa

ini bisa bermanfaat.

6.2 Pelajaran: Topologi Fitur

Topologi adalah aspek yang berguna dari layer-layer data vektor, karena meminimalkan kesa-

lahan seperti overlap atau gap.

Untuk contoh : jika dua fitur berbagi satu batas, dan Anda mengedit batas menggunakan to-

pologi, Anda tidak perlu untuk mengedit terlebih dahulu salah satu fitur, dan kemudian yang

lainnya. Cukup mengatur kedua batas sehingga bertampalan.

Tujuan dari pelajaran ini: Untuk memahami topologi menggunakan contoh-contoh.

6.2.1 Ikuti bersama: Snapping

Untuk membuat pengeditan topologi lebih mudah, lebih baik jika Anda mengatifkan snapping.

Hal tersebut akan memungkinkan kursor mouse Anda untuk snap dengan objek-objek yang lain

ketika Anda mendigitasi. Untuk mengatur pilihan snapping:

• Arahkan menu Settings → Snapping Options.....

• Atur kotak dialog Snapping options Anda seperti yang ditunjukkan gambar berikut:

• Pastikan Kotak pada kolom Avoid Int. telah dicentang.

• Klik OK untuk menyimpan perubahan Anda dan menutup kotak dialog.

• Masuk ke mode edit dan pilihlah layer rural

• Periksa View → Toolbars untuk meyakinkan bahwa toolbar Advanced Digitizing telah

tersedia.

• Perbesar pada area ini (aktifkan layer-layer dan labelnya jika dibutuhkan):
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• Digitasi bidang pertanian berikut (data hanya fiktif):
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• Ketika diminta, masukkan sebuah id 999, biarkan nilai yang lain tidak berubah.

Jika Anda berhati-hati ketika mendigitasi dan memerintah kursor untuk snap di titik simpul dari

bidang-bidang pertanian, tidak akan ada gap antara bidang pertanian baru Anda dan petanian

lama yang saling berdekatan.

• Perhatikan tool undo/redo pada toolbar Advanced Digitizing:

Tombol tersebut mungkin akan sering Anda gunakan....

6.2.2 Ikuti bersama: Menutup gap

Anda mungkin telah melihat adanya beberapa lubang besar dalam dataset rural :

118 Bab 6. Modul: Membuat Data Vektor



Quantum GIS Training Manual, Rilis 1.0

Celah berwarna putih dalam layer farms, yang tidak berwarna abu-abu di area urban yang

berwarna abu-abu, merupakan lahan pertanian yang hilang. Celah-celah tersebut perlu untuk

ditutup. Jika Anda menambahkan fitur secara normal, Anda harus sangat akurat untuk men-

cegah gap dan overlap. Meskipun Anda berusaha untuk Anda sangat akurat, tanpa snapping

titik simpul (yang Anda aktifkan di atas) tidak mungkin untuk melakukan digitasi fitur tanpa

kesalahan.

Walaupun begitu, kita memiliki tool yang lain untuk mengatasi masalah ini. Karena kita telah

memiliki topologi yang sudah aktif, ceah-celah yang ada dapat ditutup . Sebagai contoh, kita

ingin mendigitasi sebuah pertanian baru untuk menutup gap tersebut:
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Jika dilakukan tanpa bantuan topologi, proses digitasi cukup memakan waktu. Dengan Avoid

Int. ( “Menghindari perpotongan” ) diaktifkan untuk layer rural QGIS akan untuk menggunak-

an topologi untuk mencegah overlap. Jadi Anda dapat mendigitasi meskipun dengan bentuk

pendekatan yang tidak teliti:
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(Berikan nilai id dalam kisaran ratusan untuk menghindari konflik dengan fitur yang sudah

ada.)

Ketika Anda memilih fiturnya...
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... Anda akan melihat bahwa QGIS secara otomatis menambahkan node yang rinci dan me-

mastikan bahwa tidak ada overlap!

• Coba lakukan berikut sekarang:

Catatan: Pilihan “Avoid Intersection” hanya akan bekerja untuk mengeliminasi overlap. Jelas,
jika Anda mengabaikan sebuah ceah, celah tersebut tidak akan terisi secara otomatis karena

QGIS mengira Anda memang membiarkannya.

6.2.3 Coba Sendiri...

• Tutup gap yang masih tersisa menggunakan pendekatan di atas, tetapi pastikan untuk

tidak membuat fitur pertanian di atas area urban.

• Ingat untuk menyimpan hasil editan Anda, dan jika dibutuhkan, keluar dari mode edit.

Periksa hasil anda
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6.2.4 Ikuti bersama : Mengoreksi kesalahan topologi

Kesalahan topologi tidak selalu terlihat seketika. Mari kita ubah simbologi layer rural untuk

melihat beberapa kesalahan topologinya.

• Atur simbologi untuk layer rural menjadi warna tunggal (lebih baik berwarna gelap).

• Atur nilai Transparency menjadi 50%.

• Anda harus melihat hasilnya seperti berikut:

Ada beberapa hal yang diperhatikan disini. Pertama, pertanian baru yang Anda tambahkan

lebih terang dibanding yang lainnya. Ini karena dalam dataset ini, ada tingkatan yang berbeda

dari layer farms: pertanian yang luas dan subdivisinya didigitasi secara terpisah. Lahan perta-

nian yang luas dan subdivisnya yang terletak di atas yang lain, yang membuat warnanya lebih

gelap karena Anda melihat yang fitur bagian bawah melewati fitur di atasnya. Hala tersebut

adalah sifat dari dataset, sehingga bukan merupakan suatu masalah.

Tetapi Anda juga dapat memperhatikan masalah tertentu: salah satu dari pertanian berada di

bawah yang lainnya! Jelas, bahwa ini adalah sebuah kesalahan., karena dalam dunia nyata

bidang pertanian tidak overlap.Dua bidang pertanian tidak mempunyai pembagian yang sama.

Mari kita perbaiki!

• Masuk ke mode edit, jika belum diaktifkan.

• Pilih Node Tool.
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• Klik pada salah satu pojok dari pertanian yang bermasalah. Hal tersebut akan memilih

pertanian yang akan akan diedit dan Anda akan melihat node-node berikut muncul:

• Klik dan geser node-node tersebut sampai snap pada tempatnya.
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Batas yang benar secara topologi terlihat seperti berikut:
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6.2.5 Ikuti bersama: Tool: Simplify Feature

Berikut adalah tool Simplify Feature:

• Klik pada tool tersebut untuk mengaktifkannya.

• Klik pada lahan pertanian baru yang Anda buat sebelumnya. Anda akan mendapat kotak

dialog sebagai berikut:
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• Pindahkan slider dari sisi ke sisi dan lihat apa yang terjadi:

Hal tersebut memungkinkan Anda untuk mengurangi jumlah node dalam fitur yang kompleks.

Meskipun demikian, perhatikan apakah itu akibatnya pada topologi! Ahan pertanian yang di-

sederhanakan tidak lagi menyentuh lahan pertanian yang berdekatan sebagaimana yang seha-

rusnya.Tool ini lebih baik sesuai pada pembentukan fitur tunggal, memungkinkan Anda untuk

melihat pengaruh apa yang akan terjadi sebelum Anda mengimplementasikannya.

Sebelum Anda lanjut, kembalikan lahan pertanian ke posisi sebelumnya:

• Batalkan kotak dialog :guilabel:‘Simplify Feature, atau

• Jika Anda telah klik OK, lakukan undo pada perubahan terakhir.
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6.2.6 Coba sendiri... Tool: Add Ring

Berikut adalah tool Add Ring:

Tool tersebut digunakan untuk membuat lubang pada sebuah fitur, selama lubang dibatasi di

semua sisi oleh fitur tersebut. Misalnya, jika Anda telah mendigitasi batas luar dari South

Africa dan Anda perlu menambahkan lubang untuk Lesotho, Anda akan menggunakan tool ini.

• Cobalah menggunakan tool ini untuk membuat gap di pertengahan layer farm Anda.

• Undo edit ketika Anda selesai.

Periksa hasil anda

6.2.7 Coba sendiri... Tool: Add Part

Berikut adalah tool Add Part:

Tool tersebut memungkinkan Anda untuk membuat fitur tambahan dari fitur, yang tidak secara

langsung terhubung ke fitur utama. Sebagai contoh, jika Anda telah mendigitasi batas dari

mainland South Africa tetapi Anda belum menambahkan pulau Prince Edward, Anda harus

menggunakan tool ini untuk membuatnya:

• Coba gunakan tool ini untuk menambahkan properti terpencil ke dalam pertanian Anda.

• Undo edit ketika Anda selesai.

Periksa hasil anda

6.2.8 Coba sendiri... Tool : Delete Ring dan Delete Part

Berikut adalah tool Delete Ring dan Delete Part, secara berturut-turut:

Fungsi dari tool tersebut harus jelas.

• Buat part dan ring baru seperti di atas dan hapus untuk mencoba melihat bagaimana tool

tersebut bekerja.

• Anda harus mengklik dekat node (pojok) dari part atau ring dengan tujuan untuk meng-

hapusnya.
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6.2.9 Ikuti bersama : Tool : Reshape Features

Berikut adalah tool Reshape Features :

Tool tersebut menambah sebuah tonjolan pada fiturs yang sudah ada. Dengan tool yang terpilih

ini:

• Klik di dalam lahan pertanian Anda.

• Tambahkan bagian tambahan pada lahan pertanian.

• Klik kanan kembali ke lahan pertanian:
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Hasil dari pekerjaan di atas adalah sebagai berikut:

Anda dapat melakukan kebalikannya:

• Klik di luar fitur.

• Ambil bagian di luar fitur.

• Klik kanan di luar pertanian lagi:
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Hasil dari pekerjaan di atas adalah sebagai berikut:
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6.2.10 Coba Sendiri.. Tool: Split Features

Tool Split Features digunakan untuk membagi dua sebuah fitur tanpa menghilangkan salah satu

atau kedua bagiannya.

• Coba dan lihat!

• Batalkan hasilnya sebelum melanjutkan dengan latihan untuk tool berikutnya.

6.2.11 Coba sendiri... Tool : Merge Features

• Temukan dan pilih bidang pertanian ini:
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• Gunakan tool Merge Selected Features dan Merge Attributes of Selected Features.

• Lihat perbedaannya.

Periksa hasil anda

6.2.12 Kesimpulan

Pengeditan topologi adalah tool yang digunakan untuk membuat dan memodifikasi obyek de-

ngan cepat dan mudah, dan memastikan bahwa topologinya tetap benar.

6.2.13 Apa Selanjutnya?

Sekarang Anda telah mengetahui bagaimana mendigitasi bentuk suatu obyek dengan mudah,

tetapi menambahkan atribut masih sedikit memusingkan! Selanjutnya kami akan menunjukk-

an kepada Anda bagaimana untuk menggunakan formulir sehingga pengeditan atribut lebih

sederhana dan lebih efektif.

6.3 Pelajaran: Forms

Bila Anda menambahkan data baru melalui digitasi, Anda menggunakan kotak dialog yang

memungkinkan Anda mengisi atribut untuk fitur itu. Namun, kotak dialog ini tidak secara

default, nyaman untuk dilihat. Hal ini dapat menyebabkan masalah penggunaan , terutama jika
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Anda memiliki dataset besar atau jika Anda ingin orang lain untuk membantu anda mendigitasi

dan mereka menemukan bentuk – bentuk default yang membingungkan.

QGIS memungkinkan Anda membuat dialog yang sesuai untuk layer Anda sendiri.Pelajaran

ini menunjukkan caranya.

Tujuan dari pembelajaran ini : Untuk membuat bentuk untuk layer.

6.3.1 Ikuti Bersama : Menggunakan Fungsi Bentuk desain

QGIS.

• Pilih layer streets pada Layers list.

• Enter Edit Mode seperti sebelumnya.

• Buka Attribute Table itu.

• Klik kanan pada sembarang sel dalam tabel. Sebuah menu pendek akan muncul, dengan

isian Open form.

• Klik untuk melihat bentuk yang dihasilkan layer QGIS ini.

Jelas akan menyenangkan untuk melakukan hal ini sambil melihat peta, terlebih perlu untuk

mencari jalan tertentu dalam :guilabel:‘Attribute Table‘sepanjang waktu.

• Pergi ke menu Settings → Options (terletak pada baris yang sama dengan File menu,

etc.).

• Pada kotak dialog yang terlihat, pilih tab Map Tools .

• Centang pilihan Open feature form ... :
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• Tutup kotak dialog Settings dialog.

• Pilih layer streets pada Layers list.

• Gunakan tool Identify , klik pada sembarang fitur jalan pada peta.

Anda akan melihat bentuk form yang familier, bukan kotak diaog biasa dari Identify:
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6.3.2 Coba Sendiri... Menggunakan Form untuk Mengedit Nilai

Bila anda berada pada mode edit, Anda bisa menggunakan bentuk ini untuk mengedit atribut

fitur!

• Aktifkan mode edit.

• Menggunakan tool Identify, klik sepanjang jalan utama yang melalui Swellendam:

• Edit nilai LANES‘ke nilai yang benar :kbd:‘2.

• Simpan hasil editan Anda.

• Keluar dari edit mode.

• Buka Tabel Attribut dan lihat hasil editan anda disana!

Perhatikan bahwa ada lebih dari satu jalan di peta berikut ini disebut Voortrekker. Yang anda

edit memiliki TYPE dari tertiary.
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6.3.3 Ikuti Bersama: Mengatur tipe kolom untuk form

Sangat menyenangkan untuk mengedit hal-hal menggunakan formulir, tapi Anda masih harus

memasukkan segala sesuatu dengan tangan. Untungnya, bentuk memiliki berbagai jenis yang

disebut “widgets” yang memungkinkan Anda untuk mengedit data dalam berbagai cara yang

berbeda.

• Buka layer streets Layer Properties.

• Pindah ke tab Fields .Anda akan melihat:

• Klik pada tombol Line edit pada baris yang sama dengan LANES dan akan mendapat

kotak dialog yang baru.

• Dalam daftar dropdownnya, atur nilai ke Range:
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• Atur nilainya seperti ini :
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• Klik OK.

• Terapkan perubahan ke Layer Properties.

• Masuk ke mode edit.

• Klik pada tool Identify.

• Klik pada jalan Voortrekker.

Sekarang bukan memasukkan nilai secara manual, Anda dapat menggunakan panah atas dan

bawah sebelah LANES untuk mengedit nilai - nilainya!

6.3.4 Coba Sendiri...

Atur baru, widgets yang lebih tepat untuk field ini :

• TYPE
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• ONEWAY

Periksa hasil anda

6.3.5 Coba Sendiri... Membuat Tes Data

Anda juga dapat merancang form sesuai kebutuhan Anda sendiri sepenuhnya dari awal..

• Membuat layer titik sederhana dengan dua atribut :

– Nama (text)

– Umur (text)
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• Merekam beberapa titik ke layer baru dengan menggunakan tool digitasi sehingga Anda

memiliki sedikit data untuk bereksperimen. Anda harus mendapatkan default form QGIS

untuk merekam atribut yang dihasilkan setiap kali Anda menambahkan sebuah titik yang

baru.
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6.3.6 Ikuti Bersama: Membuat Form Baru

Sekarang kita ingin membuat sendiri formulir untuk merekam data atribut. Untuk melakukan

ini, Anda harus menginstall Qt4 Designer . Installer akan disediakan sebagai bagian dari materi

kursus Anda, jika Anda menggunakan Windows. Anda mungkin harus mencarinya jika Anda

menggunakan OS lain. Di Ubuntu, lakukan langkah berikut di terminal:

sudo apt-get install qt4-designer

... dan akan terinstll secara otomatis. Jika tidak, cari di and Software Center.

• Mulai Designer dengan membuka Start Menu dalam Windows.

• Di dalam dialog yang muncul, buatlah dialog baru:
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• Cari Widget Box sepanjang kiri layar Anda (default). Ini berisi item yang disebut :guila-

bel:‘Line Edit.

• Klik dan seret item ini ke form anda untuk untuk membuat form Line Edit yang baru.

• Dengan unsur edit garis baru terpilih, Anda akan melihat propertinya sepanjang sisi layar

Anda (di sebelah kanan secara default):
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• Ubah namanya menjadi Name.

• Gunakan pendekatan yang sama, membuat spinbox dan mengatur namanya dengan Age.

• Tambahkan Label dengan text Add a New Person dalam font tebal (lihat di proper-

ties objek untuk mengetahui cara mengatur ini). Atau, Anda mungkin ingin mengatur

judul dialog itu sendiri (bukan menambahkan label).

• Klik dimanapun pada kotak dialog anda.

• Cari tombol Lay Out Vertically (dalam toolbar di sepanjang tepi atas layar, secara). Ini

mengatur posisi dialog Anda secara otomatis.

• Atur ukuran maksimum dialog (dalam properti) dari 200 (width) dengan 100 (height).

• Simpan formulir anda sebagai exercise_data/forms/add_people.ui.
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• Apabila sudah selesai menyimpan,Anda bisa menutup program Qt4 Designer.

6.3.7 Ikuti Bersama: Menghubungkan Form dengan Layer An-

da

• Kembali ke QGIS.

• Klik dua kali pada layer legenda untuk mengakses properti ini.

• Klik pada tab General pada dialog Layer Properties.

• Arahkan ke path ke file ui Anda di field Edit UI field.

• Klik OK pada kotak dialog Layer Properties.

• Enter edit mode and capture a new point.

• Ketika Anda melakukannya, Anda akan mendapatkan kotak dialog buatan Anda (bukan

yang biasanya dibuat oleh QGIS).

• Jika Anda klik pada salah satu poin Anda menggunakan tool Identify , kini Anda dapat

membuka form dengan mengklik kanan di jendela hasil identifikasi dan memilih fitur

View Feature Form dari menu konteks.

• Jika Anda berada dalam mode edit untuk layer ini, konteks menu akan menunjukkan Edit

Feature Form , dan Anda kemudian dapat mengatur atribut dalam bentuk baru bahkan

sesudah pencatatan awal.

6.3.8 Kesimpulan

Penggunaan formulir akan memudahkan proses editing dan pembuatan data. Dengan mengedit

jenis widget atau menciptakan bentuk yang sama sekali baru dari awal, Anda dapat memudahk-

an pekerjaan mendigitasi data baru untuk layer itu. Lebih jauh hal ini dapat meminimalkan

kesalahpahaman dan kesalahan yang tidak perlu .

6.3.9 Baca Selanjutnya

Jika Anda menyelesaikan bagian lanjutan atas dan memiliki pengetahuan tentang Python, An-

da dapat membaca informasi di blog ini1 tentang bagaimana menciptakan bentuk fitur sesu-

ai.dengan logika Python, yang memungkinkan fungsi-fungsi lanjutan termasuk validasi data,

autocompletion, dll

6.3.10 Apa Selanjutnya?

Membuka formulir pada identifikasi fitur adalah salah satu operasi standar yang QGIS dapat

lakukan. Namun, Anda juga bisa secara langsung memerintahkan QGISuntuk melakukan tin-

1http://tinyurl.com/6tr42rb
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dakan sesuai yang Anda tetapkan. Ini adalah subyek pelajaran berikutnya .

6.4 Pelajaran : Actions

Sekarang anda telah melihat aksi default pada pelajaran sebelumnya, saatnya untuk membuat

action Anda sendiri. Suatu action adalah sesuatu yang terjadi ketika Anda mengklik pada fitur.

Hal ini dapat menambahkan banyak fungsi tambahan untuk peta Anda, memungkinkan Anda

untuk mengambil informasi tambahan tentang suatu objek, misalnya. Membuat action dapat

menambahkan dimensi baru untuk peta Anda!

Tujuan untuk pelajaran ini : Untuk mempelajari cara menambahkan action terkustomisasi.

6.4.1 Ikuti Bersama: The Actions Tab

• Buka dialog Layer Properties untuk layer rural .

• Klik pada tab Actions untuk melihat isinya.

Mari kita lihat cara kerjanya dengan menambahkan action baru.

6.4.2 Ikuti Bersama : Membuka Sebuah Gambar

Gunakan layer school_property yang Anda buat sebelumnya. Material latihan termasukfoto

yang Anda digitasi. Kita akan menghubungkan tiap bidang dengan foto-doto tersebut. Ki-

ta akan membuat action untuk membuka gambar pada sebuah properti ketika anda mengklik

properti tersebut.

6.4.3 Ikuti Bersama: Mengisi Field kepada Gambar

Layer school_property tidak memiliki fasilitas untuk menghubungkan antara sebuah foto de-

ngan bidangnya. Pertama kita membuat field.

• Buka dialog Layer Properties .

• Klik pada tab Fields .

• Tombol aktivasi Mode edit:
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• Tambahkan sebuah kolom baru :
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• Masukkan nilai berikut:

• Setelah kolom itu dibuat ,klik pada tombol Line edit disamping kolom yang baru.

• Pilih File name:
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• Klik OK pada kotak dialog Layer Properties.

• Gunakan tool Identify untuk memilih satu dari tiga fitur pada layer school_property.

Karena Anda masih dalam mode edit, kotak dialog seharusnya aktif dan tampak seperti:
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• Klik pada tab General pada dialog Layer Properties.

• Pilih direktori untuk citra Anda di exercise_data/school_property_photos/

dan beri nama seperti fitur yang akan dihubungkan.

• Klik OK.

• Hubungkan semua gambar dengan fitur yang benar menggunakan metode ini.

• Simpan hasil edit dan keluar dari mode edit.

6.4.4 Ikuti Bersama : Membuat sebuah Action

• Buka formulir Actions untuk layer school_property , seperti dijelaskan diatas untuk layer

rural.

• Masukkan kata Show Image di kolom Name :
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Apa yang dilakukan selanjutnya mengikuti sistem operasi Anda, jadi pilih bagian yang sesuai:

Windows

• Klik pada Type dan pilih Open.

Ubuntu Linux

• Dibawah Action, tuliskan :kbd:‘eog untuk Gnome Image Viewer, atau tulis display

untuk menggunakan ImageMagick. Ingat untuk menambahkan spasi setelah perintah!

MacOS

• Klik pada Type dan pilih Mac.

• Dibawah Action, tuliskan open. Ingat untuk menambahkan spasi setelah perintah!

Lanjutkan menulis perintah

Bagian selanjutnya mudah! Anda ingin membuka gambar, dan QGIS akan tahu dimana gambar

itu berada. Yang perlu dilakukan adalah memberi tahu Action dimana foto itu berada.

• Pilih image dari daftar:
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• Klik tombol Insert field.QGIS akan menambah kata [% "image" %] pada kolom

Action.

• Klik pada tombol Add to action list.

• Klik OK pada kotak dialog Layer Properties.

Sekarang lakukan pengujian tes untuk action yang baru!

• Klik pada layer school_property dalam :guilabel:‘Layers list.

• Cari tombol Run feature action (Pada toolbar yang samasebagai tombol Open Attribute

Table):

• Klik panah ke bawah di sebelah kanan tombol ini. Hanya terdapat satu action untuk

tombol ini.

• Klik tombolnya untuk mengaktifkan tool.

• Mengunakan tool ini, klik pada salah satu dari tiga properti sekolah.
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• Gambar untuk properti itu akan dibuka sekarang.

6.4.5 Ikuti Bersama : Pencarian di Internet

Kita melihat peta dan ingin mengetahui tentang area pertanian di dalamnya. Seandainya anda

tidak tahu area yang ditanyakan dan ingin menemukan informasi umum tentang hal itu. Anda

dapat menggunakan mesin pencari Google. Kita dapat mengatur QGIS supaya melakukannya

otomatis untuk kita!

• Buka tabel atribut untuk layer rural (Anda perlu menutup Layer Properties).

Terdapat beberapa kolom dengan nama area pertanian didalamnya, sebagian diantarany me-

miliki nama yang asing. Satu kolom dengan nama yang mudah dicari di Google adalah field

SGADMIN . Kita akan menggunakan kolom tersebut untuk pencarian kita.

• Tutup tabel atribut.

• Kembali ke Actions di Layer Properties.

• Di dalam kolom Action Properties → Name, tuliskan Google Search.

Apa yang dilakukan selanjutnya mengikuti sistem operasi Anda, jadi pilih bagian yang sesuai:

Windows

• Di bawah Type, pilih Open. Ini akan menyuruh jendela untuk membuat alamat internet

pada browser Anda.

Ubuntu Linux

• Di bawah Action, tuliskan xdg-open. Ini akan menyuruh Ubuntu membuka alamat

email internet pada browser.

MacOS

• Dibawah Action, tuliskan open. Ini akan menyuruh MacOS untuk membuka alamat

internet pada browser.

Lanjutkan menulis perintah

Apapun perintah yang Anda gunakan, anda perlu memberi tahu alamat internet untuk dibuka

selanjutnya. Anda ingin mengunjungi Google, dan tinggal mencari prase secara otomatis.

Pada umumnya ketika menggunakan Google, Anda ingin komputer anda ke bar pencair-

an Google. Tetapi pada kasus ini , Anda ingin komputer anda melakukan ini untuk an-

da. Cara yang dapat Anda gunakan adalah dengan memberikan pencari internet anda

dengan alamat http://www.google.co.za/search?q=SEARCH_PHRASE, dimana

6.4. Pelajaran : Actions 153



Quantum GIS Training Manual, Rilis 1.0

SEARCH_PHRASE adalah apa yang Anda ingin cari. Karena kita tidak tahu apa kata apa

yang dicari sebelumnya, kita hanya mengisi bagian pertama tanpa pencari.

• Dalam kolom Action , tuliskan http://www.google.co.za/search?q=. Ingat

untuk mengisi field perintah inisial sebelum menulis itu didalamnya!

Sekarang Anda ingin QGIS memberi tahu pencari untuk memberi tahu Google untuk mencari

nilai dari fitur – fitur SGADMIN dan anda harus mengkliknya. Terdengar rumit, tetapi QGIS

akan melakukannya dengan mudah.

• Pilih kolom SGADMIN.

• Klik Insert field:

Ini akan memberi tahu QGIS untuk menambah kata selanjutnya:

Artinya adalah QGIS akan membuka browser mengrahkannya ke alamat

http://www.google.co.za/search?q=[% "SGADMIN" %]. [% "SGADMIN"

%] memberitahu QGIS untuk menggunakan isi field SGADMIN sebagai kata untuk mencari.

Sebagai contoh, pertanian yang anda klik pada area Montagu ,kemudian QGIS akan berja-

lam untuk mengrim pencari ke http://www.google.co.za/search?q=Montagu,

sehingga browser akan membuka Google dan mencari mencari kata Montagu.

• Lakukan pengaturan seperti petunjuk di atas.

• Klik pada tombol Add to action list . Action baru akan terlihat pada daftar.

• Klik OK pada kotak dialog Layer Properties.

Sekarang lakukan pengujian tes untuk action yang baru!
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• Dengan layer rural aktif dalam Layers list, klik pada :guilabell:‘Run feature action‘.

• Klik pada sembarang bidang pertanian pada peta. Browser akan membuka , dan akan

memulai secara otomatis pencari Google untuk kota yang terekam sebagai nilai pertanian

SGADMIN.

Catatan: Jika action Anda tidak bekerja, perika apakah semua masukkan sudah benar, kesa-
lahan tulis yang paling banyak terjadi!

6.4.6 Ikuti Bersama : Membuka Sebuah Halaman Web Lang-

sung di QGIS

Anda telah melihat bagaimana membuka sebuah halaman web secara eksternal. Ada beberapa

kelemahan dalam pendekatan serta menambah ketergantungan yang diketahui. Tidak semua

pengguna memiliki perangkat lunak yang dibutuhkan untuk melaksanakan action pada sistem

mereka? Perintah yang digunakan berbeda untuk sistem operasi yang berbeda. Akan timbul

masalah jika Anda tidak tahu OS mereka gunakan. Dengan beberapa versi OS, perintah di atas

untuk membuka browser mungkin tidak bekerja sama sekali.

QGIS menggunakan Qt4yang memiliki library sangat kuat dan serbaguna. Masalah tersebut

dapat diatasi dengan menambahkan satu atau dua baris perintah Python. Action QGIS bias

di-tokenized (menggunakan informasi variabel berdasarkan isi dari atribut lapangan) perintah

Python!

Sekarang Anda akan melihat bagaimana menggunakan action python untuk menampilkan ha-

laman web. Prinsip dasarnya adalah sama seperti membuka sebuah situs di browser eksternal,

tetapi tidak memerlukan browser pada sistem pengguna karena menggunakan QWebView kelas

Qt4 (yang merupakan WebKit berbasis html widget) untuk menampilkan konten dalam jendela

pop up.

Dari pada Google, mari kita gunakan Wikipedia saat ini. Jadi URL yang anda minta akan

dilihat seperti ini :

http://wikipedia.org/wiki/SEARCH_PHRASE

Untuk membuat layer action:

• Buka dilaog Layer Properties dan sembunyikan tab :guilabel:

• Membuat action baru menggunakan pengaturan berikut: *

Type: Python * Name: Wikipedia * Action (all on

one line): from PyQt4.QtCore import QUrl; from

PyQt4.QtWebKit import QWebView; myWV = QWebView(None);

myWV.load(QUrl(’http://wikipedia.org/wiki/[%

"SGADMIN" %]’)); myWV.show()‘Set up a new action

using the following properties for the action: *
:guilabel:‘Type: Python * Name: Wikipedia * Action

(all on one line): from PyQt4.QtCore import QUrl; from

PyQt4.QtWebKit import QWebView; myWV = QWebView(None);

6.4. Pelajaran : Actions 155



Quantum GIS Training Manual, Rilis 1.0

myWV.load(QUrl(’http://wikipedia.org/wiki/[% "SGADMIN"

%]’)); myWV.show()

Terdapat beberapa hal yang terjadi disini:

• Semua kode Python adalah satu baris dengan tanda titik koma sebagai pemisah antar

perintah

• [% "SGADMIN" %] akan terganti oleh nilai atribut yang dicari ketika action dijalank-

an.

• Kodenya akan membuat instances QWebView baru, atur URLnya, dan kemudian me-

manggil show() pada desktop pengguna.

Catatan, ini adalah contoh dibuat-buat. Python bekerja dengan indentasi semantik yang sig-

nifikan, sehingga memisahkan perintah dengan titik koma bukan cara terbaik. Jadi, di dunia

nyata, Anda akan lebih mungkin untuk mengimpor perintah dari modul Python dan kemudian

memanggil fungsi dengan kolom atribut sebagai parameter.

Anda juga bisa menggunakan pendekatan untuk menampilkan foto tanpa mengharuskan peng-

guna memiliki penampil gambar pada sistem mereka.

6.4.7 Kesimpulan

Action memungkinkan Anda menambahkan fungsionalitas tambahan pada peta yang sangat

bermanfaat untuk pengguna akhir yang melihat peta yang sama di QGIS. Anda dapat menggu-

nakan perintah shell untuk sistem operasi apapun serta Python memberikan keleluasaan untuk

membuat fungsi-fungsi tambahan pada peta Anda.

6.4.8 Apa Selanjutnya?

Anda telah menyelesaikan semua jenis pembuatan data vector. Materi latihan selanjutnya ada-

lah belajar bagaimana menganalisis data untuk penyelesaian masalah.
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